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Important Information
Texas Instruments makes no warranty, either express or implied, 
including but not limited to any implied warranties of merchantability 
and fitness for a particular purpose, regarding any programs or book 
materials and makes such materials available solely on an "as-is" basis. In 
no event shall Texas Instruments be liable to anyone for special, 
collateral, incidental, or consequential damages in connection with or 
arising out of the purchase or use of these materials, and the sole and 
exclusive liability of Texas Instruments, regardless of the form of action, 
shall not exceed the purchase price of this product. Moreover, Texas 
Instruments shall not be liable for any claim of any kind whatsoever 
against the use of these materials by any other party.

Copyright © 2006, 2008 Texas Instruments Incorporated.

Microsoft® and Windows® are trademarks of their owners.

Regulatory Information

USA FCC Information Concerning Radio Frequency 
Interference

Federal Communication Commission Interference 
Statement
This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference 

Product Name: 
TI-Nspire™ Navigator™ Wireless 
Cradle

FCC ID: V7R-TINAVWC

Product Name: 
TI-Navigator™ Access Point

Model Number/Name: NAV-AP-US

FCC ID: V7R-TINAVAP
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will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged 
to try to correct the interference by one or more of the following 
measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from 
that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: The TI-Navigator™ access point and the TI-Nspire™ 
Navigator™ wireless cradle comply with Part 15 of the FCC Rules. 
Operation is subject to the following two conditions: (1) These devices 
may not cause harmful interference, and (2) these devices must accept 
any interference received, including interference that may cause 
undesired operation.

RF Radiation Exposure and Hazard Statement:
To ensure compliance with FCC RF exposure requirements, the 
TI-Navigator™ access point must be installed in a location such that the 
antenna of the device will be greater than 20 cm (8 in.) away from all 
persons. Using higher gain antennas and types of antennas not covered 
under the FCC certification of this product is not allowed. Installers of the 
radio and end users of the product must adhere to the installation 
instructions provided in this manual.

This transmitter must not be co-located or operating in conjunction with 
any other antenna or transmitter.

Non-modification Statement:
Use only the integral antenna supplied by the manufacturer when 
operating these devices. Unauthorized antennas, modifications, or 
attachments could damage the TI-Navigator™ access point or TI-Nspire™ 
Navigator™ wireless cradle and violate FCC regulations. Any changes or 
modifications not expressly approved by the party responsible for 
compliance could void the user's authority to operate this equipment.

Deployment Statement:
This product is certified for indoor deployment only. Do not install or use 
this product outdoors.
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Canadian IC Information

Industry Canada Statement:
Operation is subject to the following two conditions in Canada:

1. these devices may not cause interference, and

2. these devices must accept any interference, including interference 
that may cause undesired operation of the device

To prevent radio interference to the licensed service (i.e. co-channel 
Mobile Satellite systems) these devices areintended to be operated 
indoors and away from windows to provide maximum shielding. 
Equipment (or its transmit antenna) that is installed outdoors is subject 
to licensing and not supported by the TI-Navigator™ access point or 
TI-Nspire™ Navigator™ wireless cradle.

European Union and European Free Trade 
Association (EFTA) Regulatory Compliance
This equipment may be operated in the countries that comprise the 
member countries of the European Union and the European Free Trade 
Association. These countries, listed in the following paragraph, are 
referred to as The European Community throughout this document:

AUSTRIA, DENMARK, FINLAND, FRANCE, GERMANY, ITALY, 
NETHERLANDS, PORTUGAL, SPAIN, SWEDEN, UNITED KINGDOM,  
NORWAY, SWITZERLAND

The TI-Navigator™ access point communicates with either a TI-Navigator 
network hub or TI-Nspire™ Navigator™ wireless cradle via a wireless 
802.11b/g link to provide wireless local area networking (WLAN) 
capabilities and with a personal computer using a standard USB cable. 
The TI-Navigator access point includes one 802.11a and one 802.11b/g 
radio. In the current model, NAV-AP-US, the 802.11a radio is disabled at 
the factory and via software preventing it from being configured and 
used when installed at an end user facility

Product Name: 
TI-Nspire™ Navigator™ Wireless 
Cradle

IC ID: 451E-TINAVWC

Product Name: 
TI-Navigator™ Access Point

Model Number/Name: NAV-AP-US

IC ID: 451E-TINAVAP
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Declaration of Conformity
Marking by this symbol:

indicates compliance with the Essential Requirements of the R&TTE 
Directive of the European Union (1999/5/EC).

This equipment meets the following conformance standards:

Safety: EN 60950-1:2001 + A11:2004

EMC: EN 55022:2006, EN 55024:1998 + A1:2001 + A2:2003, EN 301-489-1 
v1.7.1, EN 301-489-17 v1.3.2, CISPR22:1997, CISPR24

Including: EN 61000-3-2, -3-3, -4-2, -4-3, -4-4, -4-5, -4-6 and -4-11. The 
product is also licensed as required for additional country specific 
standards as required for the International Marketplace.

Radio: EN 300-328 v.1.7.1 (2006-10)

Electromagnetic compatibility and Radio spectrum Matters (ERM); 
Wideband transmission systems; Data transmission equipment operating 
in the 2,4 GHz ISM band and using wide band modulation techniques. 
Certifications are harmonized to the EN standards covering essential 
requirements under article 3.2 of the R&TTE Directive. Compliance 
includes testing with the supplied integral antenna.

SAR: EN 50385:2002

European Community Declaration of Conformity
Hereby, Texas Instruments declares that the TI-Navigator™ access point 
and TI-Nspire™ Navigator™ wireless cradle are in compliance with the 
essential requirements and other relevant provisions of Directive 
1999/5/EC.

English Hereby, Texas Instruments declares that the 
TI-Navigator™ access point and TI-Nspire™ 
Navigator™ wireless cradle are in compliance 
with the essential requirements and other 
relevant provisions of Directive 1999/5/EC.

The Declaration of Conformity may be consulted 
in the Product Stewardship page at 
education.ti.com.
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Dansk Undertegnede Texas Instruments erklærer 
herved, at følgende udstyr TI-Navigator™ access 
point overholder de væsentlige krav og øvrige 
relevante krav i direktiv 1999/5/EF.

Overensstemmelsesdirektivet (Declaration of 
Conformity) kan findes på Product Stewardship 
siden på education.ti.com.

Norsk Texas Instruments erklærer herved at utstyret 
TI-Navigator™ access point er i samsvar med de 
grunnleggende krav og øvrige relevante krav i 
direktiv 1999/5/EF.

Samsvarserklæringen kan konsulteres på 
produktforvaltningssiden (Product Stewardship) 
på education.ti.com.

Suomi Texas Instruments vakuuttaa täten että 
TI-Navigator™ access point tyyppinen laite on 
direktiivin 1999/5/EY oleellisten vaatimusten ja 
sitä koskevien direktiivin muiden ehtojen 
mukainen.

Vaatimustenmukaisuusvakuutus on saatavilla 
tuotteen ympäristövaikutuksen sivulta 
osoitteessa education.ti.com.

Français Par la présente Texas Instruments déclare que 
l'appareil TI-Navigator™ access point est 
conforme aux exigences essentielles et aux autres 
dispositions pertinentes de la directive 1999/5/CE.

La déclaration de conformité peut être consultée 
sur le site education.ti.com à la page 
Responsabilité Produit (Product Stewardship)

Deutsch Hiermit erklärt Texas Instruments, dass sich das 
Gerät TI-Navigator™ access point in 
Übereinstimmung mit den grundlegenden 
Anforderungen und den übrigen einschlägigen 
Bestimmungen der Richtlinie 1999/5/EG befindet.

Die Konformitätserklärung ist unter 
Produktbetreuung (Product Stewardship) bei 
education.ti.com einzusehen.
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Italiano Con la presente Texas Instruments dichiara che 
questo TI-Navigator™ access point è conforme ai 
requisiti essenziali ed alle altre disposizioni 
pertinenti stabilite dalla direttiva 1999/5/CE.

La dichiarazione di conformità può essere 
consultata sulla pagina Product Stewardship del 
sito education.ti.com.

Nederlands Hierbij verklaart Texas Instruments dat het 
toestel TI-Navigator™ access point in 
overeenstemming is met de essentiële eisen en 
de andere relevante bepalingen van richtlijn 
1999/5/EG.

De verklaring van overeenstemming kan worden 
geraadpleegd op de pagina Product Stewardship 
(Productverantwoordelijkheid) op 
education.ti.com.

Português Texas Instruments declara que este 
TI-Navigator™ access point está conforme com os 
requisitos essenciais e outras disposições da 
Directiva 1999/5/CE.

Pode-se consultar a Declaração de Conformidade 
na página de Gestão de Produto, (Product 
Stewardship) no sítio education.ti.com.

Español Por medio de la presente Texas Instruments 
declara que el TI-Navigator™ access point 
cumple con los requisitos esenciales y 
cualesquiera otras disposiciones aplicables o 
exigibles de la Directiva 1999/5/CE.

La Declaración de Conformidad puede 
consultarse en la página de Administración de 
Productos (Product Stewardship) en 
education.ti.com.

Svenska Härmed intygar Texas Instruments att denna 
TTI-Navigator™ access point står I 
överensstämmelse med de väsentliga 
egenskapskrav och övriga relevanta 
bestämmelser som framgår av direktiv 1999/5/EG.

Förenlighetsdeklarationen kan konsulteras på 
Produktförvaltningssidan (Product Stewardship) 
på education.ti.com.
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Countries of Operation and Restrictions of Use in the 
European Community

Operation Using the 2.400 to 2.4835 GHz Channels in the 
European Community
The installer and/or end user should use the configuration utility 
provided with this product to verify the current channel of operation, the 
expected transmit power level, and to confirm that the device is 
operating in conformance with the spectrum usage rules for the selected 
European Community country. If operation is occurring outside of 
the allowable channels as indicated in this guide, then operation 
of the product must cease immediately and the installer must 
consult with the local technical support staff responsible for the 
wireless network.

These devices are intended to be operated in all countries of the 
European Community. Additional restrictions of use for the 
TI-Navigator™ access point within the European Community countries in 
the 2.400 to 2.4835 GHz band are listed below.

• The frequencies associated with channels 1 to 13 in the 2.400 to 
2.4835 GHz band are allowed to be used either indoors or outdoors 
in all countries of the European Community, except where noted 
below:

• In Greece, Italy, Latvia, and Spain the end-user must apply for a 
license from the national spectrum authority to operate this device 
outdoors. Please consult the TI Navigator User's Guide for further 
information regarding restrictions and operating conditions for 
outdoor configurations.

• In France, the following operation is permitted:

– Outdoor operation is only permitted using the 2.400 - 2.454 GHz 
band, which includes channels 1 to 7, at a maximum EIRP of 100 
mW (20 dBm).

– Outdoor operation is permitted in the 2.400 to 2.4835 GHz band 
on channels 1 to 13 at a maximum EIRP of 10 mW (10 dBm).

– Indoor operation is permitted in the 2.400 to 2.4835 GHz band 
on channels 1 to 13 at a maximum EIRP of 100 mW (20 dBm).

Warning Statements
Warning! Install the TI-Navigator™ access point in such a manner as to 
maintain a minimum of 20 cm (7.9 inches) separation distance between 
the radiating element(s) and all persons. This safety warning conforms to 
FCC radio frequency exposure limits.
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Warning! Do not touch or move the TI-Navigator™ access point when 
the antennas are transmitting or receiving.

Warning! The TI-Navigator access point and TI-Nspire™ Navigator™ 
wireless cradle are intended for indoor use only. Do not install the device 
nor operate it outdoors.

Warning! Intentional radiators, such as the TI-Navigator access point 
and TI-Nspire™ Navigator™ wireless cradle, are not intended to be 
operated with any antenna(s) other than those furnished by Texas 
Instruments. An intentional radiator may only be operated with the 
antenna(s) with which it is authorized.

Warning! The TI-Navigator access point radio(s) are disabled by default 
and can be enabled only by the system administrator using the 
Management software application.

Warning! The radio frequency band, operating channels, and transmit 
power depend on the country of operation specified by the system 
administrator during setup and configuration using the Management 
software.

Warning! Only qualified personnel must perform installation. Read and 
follow all warning notices and instructions marked on the product or 
included in the documentation.
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Overview
The TI-Nspire™ Navigator™ classroom learning system from Texas 
Instruments can help you: 

• Assess student understanding.

• Verify that students are on task.

• Use classroom results to engage students.

• Get immediate feedback from your students to promote student 
achievement.

The system is composed of two parts, hardware and software. The 
hardware creates a wireless communications network so that your 
computer can communicate with your students’ TI-Nspire™ and TI-Nspire 
CAS handhelds. The software contains a number of tools to enhance your 
classroom, including:

• Quick Poll. Lets you send polls to your students, receive the 
students’ responses to the polls, and review the poll results with your 
students.

• Screen Capture. Lets you capture your students’ calculator screens.

• Transfer tools. Multiple tools that let you send, collect, and delete 
data files on your students’ calculators.

You can obtain educational content on the Web at TI’s Activities 
Exchange (education.ti.com/activities.) Or, using the tools on the product 
CD, you can create your own:

• StudyCard™ stacks

• CellSheet™ application variables

• TI NoteFolio™ Creator text files that you transfer to TI calculators

• TImeSpan™ Creator timelines of chronological events that can be 
viewed on a TI calculator

• Data sets (lists, matrices, and so on)

There are several ways to learn to set up and use the TI-Navigator™ 
system:

• The Getting Started poster—a short version of the setup process with 
fewer details.

• The Installation Guide (this book, provided in both printed and PDF 
formats)—complete setup details, troubleshooting, and technical 
information.
1
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• The TI-Nspire™ Navigator™ Guidebook (provided in both printed 
and PDF formats)—after you install the TI-Nspire™ Navigator™ 
software on your computer, you can use the book or PDF file as a 
reference for the software tools.

The process of unpacking the equipment, setting up the hardware, and 
installing the software will probably require about two hours of your 
time.

System requirements

Minimum system requirements
• Windows® Vista Ultimate, Home, Business, or Pro installed; 

Windows® XP Professional with Service Pack 1, 2, or 3 installed; or 
Windows® 2000 with Service Pack 4 installed.

• 900 MHz Pentium-compatible CPU (1.2 GHz recommended)

• Video adapter set at 1024 x 768 screen resolution

• 256 MB RAM (512 MB recommended)

• Approximately 500 MB of available hard-disk space (to install 
TI-Navigator™ and Network Manager) (Since Class Analysis and 
Learning Check Creator were taken out, we probably need less 
space?)

• CD-ROM drive

• Available USB 2.0 (Hi-Speed USB) port on the computer

• Internet Explorer version 5.5 or higher (installed and operational)

Other requirements
• The TI-Nspire™ Navigator™ system communicates with the TI-Nspire 

and TI-Nspire CAS learning handhelds. Your school or your students 
may already own these. Handhelds are not included with the 
TI-Nspire Navigator system.

• The latest operating system (1.3) must be installed on each handheld 
used with the TI-Nspire Navigator system. These operating systems 
are included on the CD and are available at education.ti.com/latest.

• The TI-Nspire Computer Link software must be installed on your 
computer to download the latest operating system to your 
handheld. The TI-Nspire Computer Link software is available at 
education.ti.com.

• A USB cable is required to connect the TI-Nspire and TI-Nspire CAS 
handhelds to the computer. The USB cable is not included with the 
TI-Nspire Navigator system.
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Unpacking the boxes
The TI-Nspire™ Navigator™ product consists of one classroom kit and a 
combination of student kits and individual kits, depending on your 
specific order. Each kit is packaged separately. If necessary, you can 
purchase additional kits to accommodate as many as 40 students.

1. Determine which kits you have received.

2. Unpack the items from the packing materials.

3. Identify each item, and check the items against the following lists to 
make sure your order is complete.
3



Classroom kit
• 1 TI-Navigator™ access point with AC9930 power adapter

• 1 USB computer cable

• 2 CDs, one containing system and application software, and one 
containing educational activities

• This Installation Guide, the TI-Navigator™ Reference Guide, and 
other printed materials

The Standard-A to Mini-B USB cable and the black and gray 
TI-GRAPH LINK™ cables do not work with the TI-Nspire™ Navigator™ 
system.

Access point

USB cableAC9930 power adapter for 
the access point

Two CDs

Classroom kit

Two user guides
4



Student kit (up to 15 students)
• 1 TI-Nspire™ cradle charging bay with AC9940 power adapter

• 5 TI-Nspire Navigator™ wireless cradles

• 1 AC9926 power adapter for the wireless cradle

Individual kit
• 1 TI-Nspire Navigator wireless cradle with AC9926 power adapter 

Charging the wireless cradles
The TI-Nspire Navigator wireless cradles contain rechargable batteries. 
You must charge the batteries overnight before using them in your class. 
When the cradles are fully charged, they will function all day under 
continuous use. You should recharge them each night.

Student kit

Cradle charging bay

5 wireless cradles

AC9940 power adapter 
(for the charging bay)

AC9926 power adapter 
(for individual wireless 
cradles)

Wireless cradle

Individual kit

AC9926 power 
adapter
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The TI-Nspire™ cradle charging bay can hold from one to five wireless 
cradles. After you place the cradles in the charging bay, they are charged 
simultaneously until all are fully charged. If the batteries are fully 
discharged, it may take up to 12 hours to fully charge the batteries.

With five wireless cradles in the charging bay, you should charge them 
for 12 hours. Typically this is done overnight or over a weekend. When 
the wireless cradles are fully charged in the bay, the  LED shows solid 
green.

Note: You cannot damage the batteries by leaving them in the charging 
bay beyond the time needed to fully charge them. Also, it is not 
necessary to fully discharge the batteries before recharging them. 

1. Make sure you have enough (3–4) power outlets for the equipment 
you received. If necessary, obtain a plug strip so that you have plenty 
of grounded outlets.

2. Insert the small end of the AC9940 power adapter cord into the 
charging bay’s power jack.

3. Plug the other end of the adapter into a power outlet.

4. Insert each TI-Nspire™ Navigator™ wireless cradle into the TI-Nspire 
cradle charging bay. You can insert them only one way.

Note: If you purchased the individual kit and do not have a cradle 
charging bay, you can charge a single wireless cradle using the AC9930 
adapter instead.
6



Checking the LEDs
Two LEDs (small lights) at the top of each TI-Nspire™ Navigator™ 
wireless cradle blink or change colors to indicate various operations or 
status.

The  LED indicates network activity. The  LED indicates battery-
charging status.

When the wireless cradles are still in the TI-Nspire cradle charging bay:

• The  LED blinking in a green-amber-red sequence means the 
cradles are currently recharging.

• A solid green  LED means the wireless cradle is fully charged.

Before you begin
To install software on your computer, you must have administrator 
privileges when you log in to Windows®. If you don’t know whether or 
not you have administrator privileges, check with your school’s help desk 
or system administrator.

Installing
1. Insert the TI-Nspire™ Navigator™ CD in your computer’s CD-ROM 

drive. The window to the CD should open automatically.

 LEDs
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NEED NEW PICTURE!

Note: If your computer is running Windows XP Service Pack 2, you 
may see the following message. If so, click Yes to continue. IS THIS 
STILL NEEDED?

Note: If the setup program does not run, click Start > Run, and then 
type D:\Autorun.exe, where D is your CD-ROM drive, and click OK.

2. Click TI-Navigator Software, and then click Install TI-Navigator™. 

The TI-Navigator™ Setup dialog displays.

3. Click OK to continue.

4. Two separate installations will occur:

– TI-Navigator™ software

– Network Manager software

5. When the installation is complete, the TI-Nspire™ Navigator™ Setup 
dialog displays the status of installed components.
8



• If you have already purchased the software, click Activate this 
software, and then click Next. Follow the instructions on the screen 
to activate the software.

• If you have not purchased the software, click Continue with trial 
version. The screen displays how many days remain in your trial 
period.

• If you have been using the trial version and would like to purchase 
the software, click Purchase software. You can complete the 
purchase online, and will receive the license and serial number 
necessary to begin the activation process.

Activating the software allows to you continue using it past the 30-
day evaluation period. 

Note: You can contact Texas Instruments to purchase or activate the 
software during the following hours:

Hours of operation 

Europe: M-Th 9:00 - 17:00
F 10:00 - 17:00

US: M-Th 8:00 AM - 7:00 PM
F  10:00 AM - 7:00 PM

Activating the software
1. To begin the activation process, click Activate this software, and 

then click Next.
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Regardless of which activation method you prefer, you will need to 
supply the Serial Number and License Number printed on the license 
card in your DVD case.

Note: Enter the system ID exactly as shown. Be careful not to enter a 
zero for the letter O or a letter O for a zero.

• Internet — This method uses your Internet connection to 
activate your software. You provide the Serial Number and 
License Number only. This process will automatically activate 
your software.

• Web Portal — This alternative method is for a user who does 
not have an active internet connection on the computer that is 
activating the software. Visit this Web page, and insert your 
license number and serial number when prompted to retrieve an 
activation ID. The ID is displayed on the Web page. If you 
provide your e-mail address, the ID is also sent to you by e-mail.

Note: The next time you launch the TI-Nspire™ CAS Computer 
SoftwareTI-Nspire™ Computer Software software, you will see 
an option to activate. Enter the activation ID at this time to 
complete the activation process

• Phone — You provide a TI representative with the Serial 
Number and License Number as well as an Installation ID 
displayed on your screen. The representative then provides an 
Activation ID.

• I already have an Activation ID — After accepting a license 
agreement, you fill out a screen with the Serial Number, License 
Number, and the Activation ID.

Note: Your activation ID can expire. Be sure to activate as soon 
as you get your activation ID via the web portal or your call 
center representative.

2. Click an activation method, and then click Next and follow the 
instructions.

After you have activated the software, the following screen appears.
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3. To complete the activation and create a user profile, enter the 
requested information, and then click Next.

You are now ready to set up your network.

Setting up your TI-Nspire™ Navigator™ network 
the first time
A Network Setup wizard helps you activate the access point and wireless 
cradles for wireless communication. 

Before you begin
1. Make sure you have installed the TI-Nspire™ Navigator™ software 

on your computer.

2. Make sure each wireless cradle is fully charged (  LED is solid green).

3. Remove the wireless cradles from the charging bay.

The  LED changes from solid green to blinking green when you 
remove a wireless cradle from the charging bay.
11



Connecting the cables to the access point
1. Identify the cables.

2. Connect the AC9930 power adapter to the power jack on the access 
point.

3. Connect the USB cable to the access point.

Starting the wizard
A First Time Setup screen opens automatically when you complete the 
installation of the TI-Nspire™ Navigator™ software. You are immediately 
prompted to run the network setup wizard.

Note: If you want to run the Setup Wizard later, click Start > Programs > 
TI Tools > TI Network Manager. When Network Manager opens, click 
Actions > Setup Wizard.

1. Click Setup to start the wizard. 

AC9930 Power 
adapter

USB cable

USB connection

Access point, side view

Power adapter 
jack
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2. Confirm that the AC9930 power adapter is connected to the access 
point.

3. Plug the AC adapter into a power outlet.

4. Plug the USB cable into the computer.

5. Click Next to proceed with the wizard.

Your computer recognizes the new hardware component.

Network Manager sends signals to the access point to add it to the 
network.

After the access point is found, the wizard displays a message.

6. Click OK.

The next step is to add the TI-Nspire™ Navigator™ wireless cradles 
to your classroom network.

7. Make sure the wireless cradles are charged (that is, the  LED is 
green and blinking).

8. Click Switch hardware type to tell Network Manager to look for 
wireless cradles instead of hubs.

Network Manager displays a message verifying you want to switch 
hardware types.

9. Click Yes.

After a brief search for existing wireless cradles, a dialog box opens, 
listing all cradles that were found.
13



10. Highlight each wireless cradle you want to add, and click Add.

11. When all of the cradles are added, click Finish.

Installing the calculator operating system
Before you can use the calculators on the network, you must use the 
TI-Nspire™ Computer Link software to update the operating system on 
each calculator. The TI-Nspire™ Computer Link software is available at 
education.ti.com. 

All calculators on the network must have the latest operating system 
installed for the TI-Nspire™ Navigator™ system to work properly. For 
TI-Nspire™ and TI-Nspire CAS handhelds, use OS version 1.4 or higher.

1. Download the latest TI-Nspire operating software from 
education.ti.com/latest. Make note of where you save it on your 
computer’s hard drive.

2. Make sure you have connected a TI-Nspire™ handheld to your 
computer.

Note: The TI-Nspire™ Computer Link Software works with the 
TI-Nspire™ and TI-Nspire CAS handhelds only. 

3. Double-click the TI-Nspire™ Computer Link Software icon  on 
the desktop.
14



The software displays a list of connected handhelds and lets you 
select one.

Note: You can communicate with only one handheld at a time.

4. If multiple handhelds are connected, click the handheld to which you 
want to connect.

5. Click Select.

TI-Nspire™ Computer Link Software displays the Explorer tab.

6. Click Tools > Install OS.
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7. Browse to the location you saved the TI-Nspire operating system. 

8. Highlight the operating system file and click Install OS.

TI-Nspire Computer Link Software displays a message box. Click Yes.

A progress screen is displayed.

9. When the operating system software has transferred to your 
TI-Nspire handheld, click OK. You may now disconnect the handheld 
from your computer, and the operating system software will install 
itself onto your handheld.

Note: Consider keeping one or two spare handhelds with the latest 
operating system and ample memory. It is also a good idea to have spare 
cradles on hand. If a problem occurs, you can substitute a spare part.
16



Connecting the calculators to the wireless cradles
After charging the TI-Nspire™ Navigator™ wireless cradles, you are 
ready to connect the wireless cradles to the TI-Nspire and TI-Nspire CAS 
handhelds. 

1. Attach a TI-Nspire or TI-Nspire CAS handheld to each wireless cradle. 
Press firmly to make a good connection. 

When properly connected, the TI-Nspire handheld appears to be 
sitting on top of the cradle. To attach the handheld, face the screen 
upward and slide the handheld onto the top of the TI-Nspire™ 
Navigator™ wireless cradle. Be sure that both sides of the handheld 
are inserted into both of the side guides.

2. Insert each cradle into the charging bay. You can insert them only 
one way. 

At the end of the school day, return the wireless cradle to the charging 
bay and charge them overnight. The cradles are fully charged when all 
the  (power status) LEDs are solid green.
17



Installing software Apps on the calculators IS THIS 
SECTION NEEDED?

Required
Three required Apps must be installed on all the calculators on the 
network. These Apps are named NavNet (used to connect to the 
TI-Navigator™ system), EAlgACT, and Enavstk. Use the App Transfer 
utility to install the Apps.

1. Click Start > Programs > TI Tools > TI-Navigator > TI-Navigator™.

The TI-Navigator™ home screen appears. If you have not used the 
software before, the Create a Class dialog box opens, and you are 
asked if you want to set up your classroom. 

If you prefer, you can click Cancel to skip to step 3 and create your 
classes later.

2. To create classes, follow these steps.

a) Click in the Class Name box and type a name for your class.

b) Select a Class Type from the dropdown menu.

c) Click Add Class.

d) Repeat until you have created all the classes you want.

e) If you want to import a list of students into a class, click to 
select the class name in the list, and then click Import 
Students.

or

f) Click Finish. You can then enter the names of the students 
manually into each class.

Note: Refer to the TI-Nspire™ Navigator™ Reference Guide for 
details on using the TI-Nspire Navigator software.

3. On the TI-Nspire™ Navigator™ home screen, click the Tools tab.
18



4. On the Tools panel, under Utilities, double-click the App Transfer 
icon, and then click Start Transfer.

The four Apps are automatically sent out to all the calculators 
connected to the network.

Optional
Additional software Apps for the TI-Nspire™ or TI-Nspire CAS handheld 
are included on the product CD. 

• StudyCards™ Viewer

• CellSheet™ Converter App

• NoteFolio™ App

• TImeSpan™ Viewer App

You can install these items to all the calculators on the network using the 
App Transfer utility in the TI-Navigator™ software, or you can install 
them to a single calculator using a USB cable and TI-Nspire™ Computer 
Link Software.
19



Technical information

Wireless access point

Wireless network information
The TI-Nspire™ Navigator™ classroom learning system includes a wireless 
local-area network based on the IEEE 802.11b/g industry standard, also 
known as Wi-Fi (wireless fidelity). This networking standard provides 
high-speed data transfer in the license-free 2.4 GHz band. The 
TI-Nspire™ Navigator™ system has been tested to perform at a range of 
70 feet.

LEDs

Power 
jack

USB port
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If possible, avoid sources of potential interference, such as metal walls, 
microwave ovens, and wireless phones.

Access point LEDs

POWER – Indicates that the access point is receiving power from the 
power adapter.

TEST – The access point is in self-test mode. This LED should blink for a 
minute and then stop.

STATUS: 100 LINK/ACT – Indicates data transfer.

SIGNAL: 802.11 b/g – Indicates wireless link activity.

Battery information for wireless cradles
• You cannot damage the batteries by leaving them in the charging 

bay beyond the time needed to fully charge them. Also, you will not 
damage the wireless cradles by inserting or removing them from the 
charging bay at any time.

• It is not necessary to unplug the power adapter from the charging 
bay, even when no wireless cradles are present.

• To charge as many as five wireless cradles at a time, use the charging 
bay. If you only need to charge one cradle, you can connect the 
AC9926 power adapter directly from the cradle to a power outlet.

• It is not necessary to fully discharge the batteries before recharging 
them.

• Do not leave the wireless cradles in an extremely cold or extremely 
warm location, such as inside an automobile in hot weather.

• Every few weeks, you should clean the electrical contacts on the 
charging bay and the wireless cradles using a clean, dry cloth.

Storing the wireless cradles
If you need to store the TI-Nspire™ Navigator™ wireless cradles for more 
than two weeks:

• Store the cradles in a cool, dry place. 

• Fully charge the cradles at least once every 10-12 months.
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Wireless Cradle LEDs
The LEDs on each wireless cradle use various colors and blink patterns to 
indicate data activity or power status. This can occur either when the 
cradles are seated in the charging bay or when they are outside the 
charging bay.

The LEDs indicate status as follows.

 Activity LED

Color and pattern Meaning

Blinking green Indicates data transfer to and from the 
access point.

Blinking amber Not associated with the access point.
22



 Battery (Power Status) LED

Color and pattern Meaning

Changing from green 
to amber to red

The battery is charging.

Solid green Power on; fully charged and powered by a 
charging bay or power adapter.

Blinking green Power on; battery powered. The battery is 
30% to 99% charged.

Blinking amber Low battery (lower than 30% charged).

Blinking red Battery is critically low (lower than 8% 
charged).
23



Troubleshooting
This section provides troubleshooting information related to the 
TI-Navigator™ hardware and the Network Manager software. For 
information about the TI-Navigator™ software, see the TI-Navigator™ 
Reference Guide or TI-Navigator™ Help.

Lost connections
Certain actions, such as resetting the access point, can cause the 
TI-Navigator™ network to lose its connection to one or more wireless 
cradles. This can occur even when Network Manager reports that the 
cradles are responding.

If you attempt to transfer data to or from calculators, and some of the 
wireless cradles do not respond (even though they are listed as “found”), 
try to disconnect the TI-Nspire™ handheld from the offending cradle, 
and then re-connect it. 
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Messages

Problem or 
message

Possible solutions

Device not 
found

• Make sure the TI-Nspire™ handheld is 
securely connected to the TI-Nspire™ 
Navigator™ wireless cradles.

• Ensure that the access point is connected and 
its power adapter is plugged in.

• Right-click My Computer on the Windows® 
Desktop, and click Properties. Under the 
General tab, make sure your computer lists 
Windows® Vista Ultimate, Home, Business, or 
Pro; Windows® XP Professional with Service 
Pack 1, 2, or 3; or Windows® 2000 with 
Service Pack 4 installed.

Problem or 
message

Possible causes or solutions

Device is 
incorrectly 
configured

An access point 
was located, but 
one or more 
configuration 
parameters are 
set incorrectly.

Troubleshoot the Access Point procedure to 
reconfigure this device. (See “Setting up your 
TI-Nspire™ Navigator™ network the first time” 
on page 11.)

Device did not 
respond, or 
Device not 
found

No access point 
was located by 
the system. The 
cradles cannot be 
configured until 
this is corrected.

• The access point has not yet been added to 
the system.

• The access point is turned on but still 
initializing.

• Run Network Manager and click on Check 
Access Point.
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Cannot add the 
access point to 
the network

• The access point is not in a receptive state. If 
its configuration has been corrupted, reset 
the access point to the original settings. You 
will need to reconfigure the access point and 
add all the cradles to the network again. 

Device is 
incorrectly 
configured

This cradle has 
been located, but 
one or more 
configuration 
parameters are 
set incorrectly. 

• Repeat the Add cradles procedure to 
reconfigure this cradle.

• Remove the cradle and then add it back into 
the network.

The device did 
not respond

The cradle was 
previously added 
to the classroom 
network, but was 
not located at this 
time. 

• The access point was not found.

• The cradle is too far away from the access 
point. Try to keep the cradles within 70 feet 
of the access point.

• If you changed the channel, try removing all 
the cradles and then adding all the cradles 
back into the network.

Problem or 
message

Possible causes or solutions
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The device did 
not respond, or 
cradle is not listed 
in the Network 
Manager window.

• Refresh the network status. After checking 
for the previous conditions, refresh the status 
screen to see if the cradle has been detected.

• Make sure the cradle’s battery is fully charged 
or verify that the power adapter is connected.

• Make sure the cradle is within range of the 
access point.

• When in the process of adding cradles, be 
patient. It may take up to 30 seconds after 
resetting a cradle before it is recognized and 
configured by the software. 

• Sometimes you must choose a different 
channel to avoid interference and improve 
reception. If you changed the channel, try 
removing all the cradles and then adding all 
the cradles back into the network.

• If more than one network is located in the 
same area, cradles sometimes associate with 
the wrong access point. To avoid this, make 
sure that cradles are added to only one 
TI-Nspire™ Navigator™ system at a time, and 
make sure a TI-Nspire™ Navigator™ system in 
a nearby classroom is not adding cradles at 
the same time. 

Communication 
Error

One or more 
cradles is not 
communicating 
with the access 
point.

• To restore communication between the cradle 
and access point, click View > Refresh. 

• If the error message remains, select the 
cradles that are not working, remove them 
from the network, and then add them back 
into the network.

Problem or 
message

Possible causes or solutions
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The batteries in 
the wireless 
cradles run down 
during class time, 
resulting in dead 
or low batteries.

• Make sure the wireless cradles are recharged 
overnight at least every other night. If your 
system is used heavily during the day, 
recharge the batteries every night. 

• Normally, the wireless cradle’s rechargable 
batteries can be recharged and used for up to 
three years. If you charge a battery overnight 
and the LED on the network cradle still blinks 
red or amber, contact Texas Instruments for 
help.

Extra cradles 
appear on the 
network

• Do not attempt to configure more than one 
classroom network at the same time.

• Remove the network connector from cradles 
that you do not want to add to your network.

• Compare the cradle numbers listed in the 
Network Manager window with the numbers 
stamped on the backs of the cradles 
themselves. Highlight and remove any cradles 
in the list that should not be part of your 
network.

Data is received 
by some 
calculators, but 
not all.

• Make sure the TI-Nspire™ handheld is 
securely connected to the TI-Nspire™ 
Navigator™ wireless cradles.

• Make sure all of the calculators have the 
latest operating system from Texas 
Instruments installed.

• Make sure the calculator’s RAM is not 
completely full.

• Make sure an alternate operating system, 
such as Mirage, is not installed. If found, 
remove it from the calculator.

The calculator 
does not respond 
in any way, and 
appears to be 
“locked up.”

• Reset the calculator. For instructions, refer to 
the guidebook for the calculator.

Problem or 
message

Possible causes or solutions
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You have a 
conflict on the 
operating 
channel used by 
your 
TI-Navigator™ 
access point.

• A conflict could be caused if another access 
point or a cordless telephone is using the 
same channel. 

• To try a different channel, open Network 
Manager, click Actions > Setup Wizard, click 
Next, select your hardware type, and click 
Next. On the Operating Channel Selection 
screen, in the Operating Channel list, click a 
different channel number, and click Finish. If 
the changing the channel doesn’t correct the 
problem, try a different channel.

Problem or 
message

Possible causes or solutions
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Texas Instruments Support and Service

For general information 

For TI-Navigator™ technical questions

For product (hardware) service
Customers in the U.S., Canada, Mexico, Puerto Rico and Virgin 
Islands: Always contact Texas Instruments Customer Support before 
returning a product for service.

All other customers: Refer to the leaflet enclosed with this product 
(hardware) or contact your local Texas Instruments retailer/distributor.

Home Page: education.ti.com

KnowledgeBase and 
e-mail inquiries:

education.ti.com/support

Phone: (800) TI-CARES / (800) 842-2737
For U.S., Canada, Mexico, Puerto Rico, and 
Virgin Islands only

International 
information:

education.ti.com/international

E-mail: ti-navigator@ti.com

Phone: (866) TI-NAVIGATOR / (866) 846-2844
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Battery Precautions for Calculators
Take these precautions when replacing batteries.

THERE IS A RISK OF EXPLOSION IF REPLACED BY AN INCORRECT TYPE. 
REPLACE ONLY WITH THE SAME OR EQUIVALENT TYPE RECOMMENDED 
BY TEXAS INSTRUMENTS. DISPOSE OF USED BATTERIES ACCORDING TO 
LOCAL REGULATIONS.

• Do not leave batteries within the reach of children.

• Do not mix new and used batteries. Do not mix brands (or types 
within brands) of batteries.

• Do not mix rechargeable and non-rechargeable batteries.

• Install batteries according to polarity (+ and - ) diagrams.

• Do not place non-rechargeable batteries in a battery recharger.

• Properly dispose of used batteries immediately.

• Do not incinerate or dismantle batteries.
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Battery Precautions for Rechargeable Battery 
Packs
The TI-Nspire™ Navigator™ wireless cradle contains a Lithium Ion 
battery pack. Adherence to the following instructions and cautions will 
help you get the most from your battery pack.

Contact TI if you have problems with the battery.

WARNING: THERE IS A RISK OF EXPLOSION IF REPLACED BY AN 
INCORRECT TYPE. REPLACE ONLY WITH THE SAME OR EQUIVALENT TYPE 
RECOMMENDED BY TEXAS INSTRUMENTS. DISPOSE OF USED BATTERIES 
ACCORDING TO LOCAL REGULATIONS. DO NOT RECHARGE, 
DISASSEMBLE, CRUSH, HEAT ABOVE 140º (60º C), OR INCINERATE.

Always follow the following guidelines:

• Replace only with TI-specified battery pack.

• Use only in TI-Nspire™ Navigator™ wireless cradles.

• Do not disassemble, puncture, crush, or incinerate batteries.

• Charge batteries only with an approved charger designed for use 
with your Texas Instruments product.

• Do not place non-rechargeable batteries in a battery recharger.

• Properly dispose of used batteries immediately. Do not leave them 
within the reach of children.

• Remove batteries for disposal in accordance with your local 
regulations before disposing of the TI-Navigator™ system.

Storage
• Remove batteries from the calculator.

• Store in controlled climate conditions between 20 degrees C and 35 
degrees C.

• Avoid high temperature storage conditions. Do not store under 
sunlight or in an automobile.

• Recharge after storing if rechargeable.

• Do not leave batteries within reach of children.
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